# Table of Contents

1.0 System Features .................................................................................................................. 1

2.0 System Description and Documentation.................................................................................. 2

3.0 General Description .............................................................................................................. 3

4.0 Installing and Configuring an OPC Server ............................................................................. 3

   4.1 Installing KEPServerEX and Starting a Project.................................................................... 3

   4.2 Creating a Channel................................................................................................................. 4

   4.3 Creating a Device.................................................................................................................... 9

   4.4 MAQ®20 Demonstration System and Addressing Overview.................................................. 14

   4.5 Creating Tag Groups and Tags............................................................................................... 16

       4.5.1 Creating Tags for the MAQ20-JTC, -KTC, -TTC or -RSTC Input Module................. 17

       4.5.2 Creating Tags for the MAQ20-MVDN, -VDN, -VSN, -IDN or -ISN Input Module....... 19

       4.5.3 Creating Tags for the MAQ20-VO or -IO Output Module ............................................ 21

       4.5.4 Creating Tags for the MAQ20-DIOL Discrete Input/Output Module.......................... 23

5.0 Reading and Writing Data with the OPC Quick Client.......................................................... 25

6.0 Operating the MAQ®20 Process Simulator with the OPC Quick Client .................................. 26

   6.1 Read Ambient Temperature.................................................................................................. 26

   6.2 Read VOUT2 LED Bar Control Monitor.............................................................................. 27

   6.3 Control the VOUT1 LED Bar.............................................................................................. 27

   6.4 Control TC Heat 1................................................................................................................. 27

   6.5 Read Bat Toggle Switch Position.......................................................................................... 28

   6.6 Control Motor Pot 1............................................................................................................. 28

7.0 OPC Server Setup File ........................................................................................................ 28

8.0 References.......................................................................................................................... 29
About Dataforth Corporation

“Our passion at Dataforth Corporation is designing, manufacturing, and marketing the best possible signal conditioning, data acquisition, and data communication products. Our mission is to set new standards of product quality, performance, and customer service.” Dataforth Corporation, with more than a quarter century of experience, is the worldwide leader in Instrument Class® Industrial Electronics – rugged, high performance signal conditioning, data acquisition, and data communication products that play a vital role in maintaining the integrity of industrial automation, data acquisition, and quality assurance systems. Our products directly connect to most industrial sensors and protect valuable measurement and control signals and equipment from the dangerous and degrading effects of noise, transient power surges, internal ground loops, and other hazards present in industrial environments.

Dataforth spans the globe with more than 50 International Distributors and US Representative Companies. Our customers benefit from a team of over 130 sales people highly trained in the application of precision products for industrial markets. In addition, we have a team of application engineers in our Tucson factory ready to solve any in-depth application questions. Upon receipt of an RFQ or order, our Customer Service Department provides fast one-day delivery information turnaround. We maintain an ample inventory that allows small quantity orders to be shipped from stock.

Dataforth operates under an ISO9001:2008 quality management system.

Contacting Dataforth Corporation

<table>
<thead>
<tr>
<th>Contact Method</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail:</td>
<td><a href="mailto:techinfo@dataforth.com">techinfo@dataforth.com</a></td>
</tr>
<tr>
<td>Technical Support</td>
<td></td>
</tr>
<tr>
<td>Website:</td>
<td><a href="http://www.dataforth.com">www.dataforth.com</a></td>
</tr>
<tr>
<td>Phone:</td>
<td>520-741-1404 and toll free 800-444-7644</td>
</tr>
<tr>
<td>Fax:</td>
<td>520-741-0762</td>
</tr>
<tr>
<td>Mail:</td>
<td>Dataforth Corporation</td>
</tr>
<tr>
<td></td>
<td>3331 E. Hemisphere Loop</td>
</tr>
<tr>
<td></td>
<td>Tucson, AZ 85706 USA</td>
</tr>
</tbody>
</table>

Errata Sheets

Refer to the Technical Support area of Dataforth’s website (www.dataforth.com) for any errata information on this product.
1.0 System Features

The MAQ®20 Data Acquisition System encompasses more than 25 years of design excellence in the process control industry. It is a family of high performance, DIN rail mounted, programmable, multi-channel, industrially rugged signal conditioning I/O and communications modules.

Instrument Class Performance
- ±0.035% Accuracy
- Industry leading ±0.3°C CJC Accuracy over full operating temperature range
- Ultra low Zero and Span Tempco
- Over-range on one channel does not affect other channels
- 1500Vrms Channel-to-Bus Isolation
- 240Vrms Continuous Field I/O Protection
- ANSI/IEEE C37.90.1 Transient Protection
- Ventilated Communications and I/O Modules
- Industrial Operating Temperature of -40°C to +85°C
- Wide Range 7-34VDC Power
- CE Compliant, UL/CUL Listing and ATEX Compliance pending

Industry Leading Functionality
- The system is a Modbus Server and can be operated remotely with no local PC
- Up to 4GB of logged data can be transferred via FTP during real-time acquisition
- Up to 24 I/O modules, or 384 channels, per system, per 19" rack width
- Per-channel configurable for range, alarms, and other functions
- Backbone mounts within DIN rail and distributes power and communications
- System firmware automatically registers the installation and removal of I/O modules
- I/O modules can be mounted remotely from the Communications Module
- Equal load sharing power supply modules allow for system expansion
- Hot Swappable I/O modules with Field-side pluggable terminal blocks on most models
- Sophisticated package enables high density mounting in 3U increments
- DIN Rail can be mounted on a continuous flat panel or plate

Distributed Processing Enables Even More Functionality
- Output modules are programmable for user-defined waveforms
- Discrete I/O modules have seven high level functions:
  - Pulse Counter
  - Frequency Counter
  - Waveform Measurement
  - Time Between Events
  - Frequency Generator
  - PWM Generator
  - One-Shot Pulse Generator

Multiple Software Options
- Free Configuration Software
- Intuitive Graphical Control Software
  - ReDAQ Shape Graphical HMI Design & Runtime Solution
  - IPEmotion Multi-Vendor and Multi-Language Solution
  - Programming examples and LabVIEW VIs
  - OPC Server
2.0 System Description and Documentation

A MAQ®20 Data Acquisition System must have as a minimum a Communications Module, a Backbone, and one I/O Module. Examples include:

- MAQ20-COMx Communications Module with Ethernet, USB and RS-232 or RS-485 Interface
- MAQ20-DIOx Discrete Input / Output Module
- MAQ20-xTC Type x Thermocouple Input Module
- MAQ20-mVxN, -VxN Voltage Input Module
- MAQ20-IxN Process Current Input Module
- MAQ20-IO, -IO, -VO Process Current Output and Process Voltage Output Module
- MAQ20-BKPLx x Channel System Backbone

Refer to www.dataforth.com for a complete listing of available modules and accessories.

System power is connected to the Communications Module, which in turn powers the I/O modules. For systems with power supply requirements exceeding what the Communications Module can provide, the MAQ20-PWR3 Power Supply module is used to provide additional power. When a MAQ®20 I/O module is inserted into a system, module registration occurs automatically, data acquisition starts, and data is stored locally in the module. The system is based on a Modbus compatible memory map for easy access to acquired data, configuration settings and alarm limits. Information is stored in consistent locations from module to module for ease of use and system design.

MAQ®20 modules are designed for installation in Class I, Division 2 hazardous locations and have a high level of immunity to environmental noise commonly present in heavy industrial environments.

MAQ®20 communications modules provide connection between a host computer and a MAQ®20 Data Acquisition System over Ethernet, USB, RS-485 or RS-232. Ethernet communications use the Modbus TCP protocol, USB communications are based on the Modbus RTU protocol, and RS-485 and RS-232 communications use the Modbus RTU protocol. Serial communications over RS-485 can be either 2-wire or 4-wire. Each MAQ20-COMx module can interface to up to 24 MAQ®20 I/O modules in any combination allowing high channel counts and great flexibility in system configuration. A removable microSD card can be used by the MAQ20-COMx module to log data acquired from the MAQ®20 I/O modules.

For details on hardware installation, configuration, and system operation, refer to the manuals and software available for download from www.dataforth.com. This includes, but is not limited to:

- MA1036 MAQ®20 Quick Start Guide
- MA1040 MAQ®20 Communications Module Hardware User Manual
- MA1041 MAQ®20 milliVolt, Volt and Current Input Module Hardware User Manual
- MA1037 MAQ®20 Configuration Software Tool User Manual
- MA1038 MAQ®20 ReDAQ Shape for MAQ®20 User Manual
- MAQ20-940/941 ReDAQ® Shape Software for MAQ®20 – Developer Version/User Version
- MAQ20-945 MAQ®20 Configuration Software Tool
- MAQ20-952 IPEMotion Software for MAQ®20
3.0 General Description

The MAQ®20 OPC Server provides a common interface to the MAQ®20 Data Acquisition System usable by any SCADA, HMI or other custom software that is an OPC Client. This eliminates the need for a custom interface or driver when using the MAQ®20 with industry standard software. The server enables real time information exchange on local hosts or over distributed networks.

An OPC Server consists of three basic parts – Channels, Devices, and Tags.

Channel - A Channel represents the communication medium from the host PC to one or more devices. The MAQ20-COM2 has an RS-232 port and an Ethernet port. Each would be a channel in an OPC server. The MAQ20-COM4 has an RS-485 port and an Ethernet port. Each would be a channel in an OPC server. The MAQ20-COM2 and MAQ20-COM4 support simultaneous connections over the serial and Ethernet ports.

Device - A Device is the hardware with which the server communicates. The device driver that the channel is using restricts the devices that can be connected. For the MAQ®20 OPC Server, the MAQ®20 Data Acquisition System is the Device.

Tag - A Tag represents addresses within the hardware with which the server communicates. The KEPServerEX allows both Dynamic tags and user-defined Static tags. Dynamic tags are entered in the OPC client and specify device data. User-defined Static tags are created in the server and support tag scaling. When the MAQ®20 Data Acquisition System is used as the Device, tags are assigned to the addresses within the MAQ®20 I/O modules and communication modules which data is to be read from and written to.

4.0 Installing and Configuring an OPC Server

The OPC Server implementation outlined in this manual uses the KEPServerEX server and Modbus TCP driver from Kepware Technologies. For further information and technical support related to KEPServerEX, including server and driver software download, knowledge base, user manuals, and video tutorials, visit www.kepware.com/Support_Center.

4.1 Installing KEPServerEX and Starting a Project

Download and install KEPServer EX V5.16. During the installation process, choose the Communications Drivers and Plug-Ins appropriate for the project. Select the OPC Quick Client. At a minimum, under Communications Drivers, select the Modicon Modbus Suite.
Open the software. This will connect the Configuration tool to the Runtime engine. Select ‘Yes, Update’. Select File > New or click on the New Project icon to build a project.

4.2 Creating a Channel

A channel is a representation of the communications media. For this example, communications will be over Ethernet using the Modbus TCP protocol. A channel for MAQ®20 can also be established over an RS-232 or RS-485 serial port.

Click on the prompt to add a new channel, or click on the icon in the toolbar, or choose Edit > Channels/Devices > New Channel. Assign the channel a unique name.
Select the device driver from the drop down list. If the Modbus TCP/IP Ethernet driver is not installed, exit the setup process and run the KEPServerEX installation again. The installation routine will allow the user to modify the existing installation and install additional drivers.

Check the Enable diagnostics box to capture communications between the Channel and the Device. This is useful for troubleshooting communications problems. Click Next.

Select Virtual Network > None and click Next.

Before continuing with the OPC server setup, the MAQ®20 and host computer Ethernet port configurations need to be verified.
The standard method of Ethernet connection to the MAQ®20 is to use a static IP address. The factory default is:

**MAQ®20 factory default static IP address: 192.168.128.100**

If desired, the IP address can be changed using the MAQ®20 Configuration Software Tool or ReDAQ® Shape Software for MAQ®20.

Configure the Ethernet port on the host computer to also use a static IP address. In Windows 7, this is done by choosing Control Panel > Network and Sharing Center. Next select Change Adapter Settings, select the network adapter to be used for the Channel and select Properties.

Select TCP/IPv4 and Properties.

Configure the port to use a static IP address.

**Host computer static IP Address:** 192.168.xxx.xxx

*choose any address that does not match the one set in the MAQ®20.

**Host computer Subnet Mask:** 255.255.0.0
Now that the MAQ®20 and the host computer port have been configured, return to the OPC server setup.

Select the Ethernet port which the Device (MAQ®20) is connected to. Default uses the first Ethernet card in the find order. When multiple Ethernet cards are installed in a host computer, choose the one dedicated to the Device.

Write Optimizations are used to optimize a system and prevent too many writes from overloading the ability to read. Choose the default setting and click Next.
Choose the default settings for Non-Normalized Float Handling and Socket settings.

Review the summary page and click Finish to create the Channel. Most properties of the Channel can be changed later by selecting the channel and clicking Properties. Once a channel is created, the driver cannot be changed.
4.3 Creating a Device

A Device represents the hardware that will be communicated with over the Channel. For the MAQ®20 OPC Server, the Device is the MAQ®20 Data Acquisition System. When building larger systems, an OPC server can have multiple devices under a single channel, or multiple channels with one or more devices under each channel.

Click on the prompt to add a new device, or click on the icon in the toolbar, or choose Edit > Channels/Devices > New Device. Assign the Device a unique name. The OPC Server will be set up to interface to the MAQ20DEMO-B demonstration hardware and process simulator.

Select the Modbus device model.

Next enter the Device ID. For Ethernet devices this is the IP address and the MAQ®20 factory default is 192.168.128.100. For serial devices this is the serial device ID and the MAQ®20 factory default is 16.

For Ethernet connections, the fifth character represents the Ethernet gateway. This will auto-fill as zero unless otherwise specified. When using DHCP, the hostname can be entered.
For Scan Mode, keep the default selection to Respect client specified scan rate.

Timing is dependent on the device connected to, how the connection is made and the distance to the device. Connection timeout is specific to Ethernet drivers and bus drivers and is the elapsed wait time before timeout while trying to establish a connection. Request timeout is the amount of wait time for a specific data request to be returned before timeout. Fail after specifies how many requests are attempted before the request is considered a failure. Inter-request delay is used when there are radio modems in the communication channel. A delay of 1 to 2 milliseconds allows the modem to switch from transmit to receive before the server continues processing I/O requests. The timing default values are sufficient for basic MAQ®20 systems.
Device demotion is used when multiple devices are connected to a channel. Device communication is sequential at the specified poll rate, and if one device has a fault or timeout, communication with the others is delayed and can add significant time to the poll cycle. Discard writes will avoid undesired system action due to unexpected or erroneous data when a system comes back online after timeout.

Database Creation is used for auto-tag generation. This feature is currently not available for the MAQ®20.

Keep the default Ethernet selections.
Under Data Access, unselect the User zero based addressing checkbox.

Select the defaults for Data Encoding Settings.

Select the default Block Sizes. Changing these values may optimize server operation but can also inhibit operation.
Variable Import Settings are used for auto-tag generation and is not used for the MAQ®20.

If Error Handling is unselected, a tag will be invalidated instead of deactivated when the server receives certain exception codes from the device. A tag remains invalidated and data is invalid only for the remainder of the poll cycle. A deactivated tag is removed from the poll cycle and is not re-added until the client is connected.

Review the summary page and click Finish to create the Device. Device properties can be changed later by selecting the device and clicking Properties.
4.4 MAQ®20 Demonstration System and Addressing Overview

Tags represent addresses within the MAQ®20 Data Acquisition System which the server reads data from and writes data to. Channel data for the MAQ®20 Input and Output modules is stored starting at address 1000. The MAQ®20 Data Acquisition System uses an automated registration process which periodically scans the system and will detect when MAQ®20 I/O modules are added and removed.

Each module is assigned an address space of 2000 addresses based on the Registration Number and starting at address 2000. I/O module with Registration Number 1 is assigned address space 2000 – 3999, I/O module with Registration Number 2 is assigned address space 4000 – 5999 and so on. The starting address for the module is very important because this is the offset address that must be added to the addresses listed in the I/O module address map to know where data for that module is located within the system level address map. The MAQ20-COMx Communication Module is always assigned a Registration Number of 0.

Address Maps for each module are found at the end of the individual MAQ®20 I/O and Communication module hardware user manuals. A few of these are listed below.

- MA1040 MAQ®20 Communications Module Hardware User Manual
- MA1041 MAQ®20 milliVolt, Volt and Current Input Module Hardware User Manual
- MA1042 MAQ®20 Voltage & Current Output Module Hardware User Manual
- MA1043 MAQ20-DIOL Discrete IO Module Hardware User Manual
- MA1044 MAQ®20 RTD-Potentiometer Input Module Hardware User Manual
- MA1046 MAQ®20 Strain Gage Input Module Hardware User Manual
- MA1047 MAQ®20 TC Input Module Hardware User Manual
- MA1048 MAQ®20 Frequency Input Module Hardware User Manual

The OPC Server will be set up to interface to the MAQ20DEMO-B demonstration hardware. This system is comprised of a MAQ20-COM2 or –COM4 communications module and 4 I/O modules which connect to a Process Simulator to allow user input and output and give visual feedback.
The system details can be viewed using the MAQ®20 Configuration Software Tool or ReDAQ® Shape Software for MAQ®20.

Modbus Function Codes
The MAQ®20 Data Acquisition System supports the following Modbus function codes (commands):

- 3, Read Input Registers
- 4, Read Holding Registers
- 6, Write Single Register
- 16, Write Multiple Registers
Modbus Addresses

The system makes no distinction between Modbus Input registers and Modbus Holding registers. Read Input Registers will return the same data as Read Holding Registers as long as both commands use the same address and quantity.

Modbus addresses are 0-based, meaning the first address is 0x0000 (0) and the last is 0xFFFF (65535). Address values map directly to address fields of all Modbus commands. Although only a small percentage of available Modbus addresses are mapped to data and/or control functions, the system allows access to the entire range of Modbus addresses. If a Read command accesses an address that the system does not map, 0x0000 will be returned. If a Write command accesses an address that the system does not map, the write will have no effect.

Modbus Exceptions

The system will return the following Modbus exception codes under the given conditions:

- 1, Illegal Function: The received function code is unknown or not supported.
- 2, Illegal Address: The received address and quantity would access data beyond address 0xFFFF.
- 3, Illegal Data: The number of bytes in the request does not match that expected or one or more fields of the command contains an invalid value (i.e., a quantity field is zero or too large, a byte count field is zero or does not agree with the quantity field, etc.).
- 6, Server Busy: This exception only occurs with Modbus TCP and indicates that the MAQ®20 Data Acquisition System is already processing its maximum number of simultaneous transactions and cannot accept more. The request should be re-issued after a response is received from one of the four active transactions.

4.5 Creating Tag Groups and Tags

Click on the prompt to add a new tag, or click on the New Tag Group or New Tag icon in the toolbar, or choose Edit > Channels/Devices > New Tag Group or New Tag.

First, Tag Groups will be created for each I/O module in the Demonstration System.

Next, assign tags to individual channels on each of the I/O modules.
4.5.1 Creating Tags for the MAQ20-JTC, -KTC, -TTC or -RSTC Input Module

On the demonstration system, the MAQ20-JTC module Ch 6 measures the signal from a simulated heated thermocouple and Ch 7 measures the thermocouple protruding from the Process Simulator. TC Heat 1 control is driven by MAQ20-VO Ch 4

To determine the address to read from, use the Address Map for the MAQ20-xTC Types J, K, T, R and S Thermocouple Input Modules found in the appendix of MA1047 MAQ20 TC Input Module Hardware User Manual. An excerpt from the Address Map is shown below. Channel Data is stored starting at address 1000.

NOTE: When a module is registered in a system, addresses are offset by 2000 * R, where R is the Registration Number.

<table>
<thead>
<tr>
<th>Start Address</th>
<th>Read/Write</th>
<th>Number of Registers</th>
<th>Contents</th>
<th>Description</th>
<th>Data Range</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>R/W</td>
<td>8</td>
<td>Channel Data</td>
<td>Data for all 8 Channels</td>
<td>See Table</td>
<td>INT16</td>
</tr>
</tbody>
</table>

The MAQ20-JTC module in the demonstration system has a registration number of 1 and an address offset of 2000 * 1 = 2000.

To read from Input Registers using the OPC server, use base address range 300000. The addresses to read from are then 300000 + 2000 (address offset) + 1006 (MAQ20-JTC Ch 6) = 303006 and 300000 + 2000 (address offset) + 1007 (MAQ20-JTC Ch 7) = 303007.

Choose Data type = Short and Client access = Read Only. Scan rate is only for non-OPC clients.

MAQ®20 input module input ranges can be set on a per-channel basis. This can be set or checked using the MAQ®20 Configuration Software Tool or ReDAQ® Shape Software for MAQ®20.
Data stored in the MAQ®20 addresses is in raw counts. To convert this to engineering units, use the count mapping tables in the appendix of the specific MAQ®20 Hardware User Manual.

### MAQ20-JTC Range Table

<table>
<thead>
<tr>
<th>Range</th>
<th>Standard Input Temperature</th>
<th>Equivalent Counts</th>
<th>Over/Under Range</th>
<th>Equivalent Counts</th>
<th>Deg C per Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-100°C to +760°C (Default)</td>
<td>-539 to 4095</td>
<td>-102°C to +775°C</td>
<td>-550 to 4177</td>
<td>0.1855</td>
</tr>
<tr>
<td>1</td>
<td>-100°C to +393°C</td>
<td>-1078 to 4236</td>
<td>-102°C to +401°C</td>
<td>-1100 to 4321</td>
<td>0.0928</td>
</tr>
<tr>
<td>2</td>
<td>-100°C to +199°C</td>
<td>-2156 to 4290</td>
<td>-102°C to +203°C</td>
<td>-2199 to 4376</td>
<td>0.0464</td>
</tr>
</tbody>
</table>

Using this information, scaling can be entered in the tag configuration. Use linear scaling, enter the raw count range from the Range Table, select data type Float and enter the corresponding high and low temperature. Scaled values can be clamped to prevent out of range scaling errors and can be negated if desired. Enter units of degrees Celsius.

Click OK to add the tag.
4.5.2 Creating Tags for the MAQ20-MVDN, -VDN, -VSN, -IDN or -ISN Input Module

On the demonstration system, MAQ20-VDN module Ch 0 measures a 0 to 3V signal for the green LED bar display, labeled VOUT2, which is controlled by Motor Pot 1 and Ch 5 measures a 0 to 250mV signal from the TC Heat 1 control which is driven by MAQ20-VO Ch 4.

To determine the address to read from, use the Address Map for the MAQ20-MVDN, -VDN, -VSN, -IDN or –ISN Input Modules found in the appendix of MA1041 MAQ20 mV-V-mA Input Module Hardware User Manual. An excerpt from the MAQ20-VDN Address Map is shown below. Channel Data is stored starting at address 1000.

NOTE: When a module is registered in a system, addresses are offset by 2000 * R, where R is the Registration Number.

<table>
<thead>
<tr>
<th>Address Range 1000 - 1699 : Module Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Address</td>
</tr>
<tr>
<td>1000</td>
</tr>
</tbody>
</table>

The MAQ20-VDN module in the demonstration system has a registration number of 2 and an address offset of 2000 * 2 = 4000.

To read from Input Registers using the OPC server, use base address range 300000. The addresses to read from are then 300000 + 4000 (address offset) + 1000 (MAQ20-VDN Ch 0) = 305000 and 300000 + 4000 (address offset) + 1005 (MAQ20-VDN Ch 5) = 305005.

Choose Data type = Short and Client access = Read Only. Scan rate is only for non-OPC clients.

MAQ®20 input module input ranges can be set on a per-channel basis. This can be set or checked using the MAQ®20 Configuration Software Tool or ReDAQ® Shape Software for MAQ®20.
Data stored in the MAQ®20 addresses is in raw counts. To convert this to engineering units, use the count mapping tables in the appendix of the specific MAQ®20 Hardware User Manual.

MAQ20-VDN Range Table

<table>
<thead>
<tr>
<th>Range</th>
<th>Standard Input Voltage</th>
<th>Equivalent Counts</th>
<th>Over/Under Range</th>
<th>Equivalent Counts</th>
<th>Volts per Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-60V to +60V</td>
<td>-4016 to 4016</td>
<td>-61.2V to +61.2V</td>
<td>-4096 to 4095</td>
<td>14.94*10^-3</td>
</tr>
<tr>
<td>1</td>
<td>-40V to +40V</td>
<td>-4016 to 4016</td>
<td>-40.8V to +40.8V</td>
<td>-4096 to 4095</td>
<td>9.961*10^-3</td>
</tr>
<tr>
<td>2</td>
<td>-20V to +20V</td>
<td>-4016 to 4016</td>
<td>-20.4V to +20.4V</td>
<td>-4096 to 4095</td>
<td>4.980*10^-3</td>
</tr>
<tr>
<td>3</td>
<td>-10V to +10V</td>
<td>-4016 to 4016</td>
<td>-10.2V to +10.2V</td>
<td>-4096 to 4095</td>
<td>2.490*10^-3</td>
</tr>
<tr>
<td>4</td>
<td>-5V to +5V (Default)</td>
<td>-4016 to 4016</td>
<td>-5.1V to +5.1V</td>
<td>-4096 to 4095</td>
<td>1.245*10^-3</td>
</tr>
</tbody>
</table>

Using this information, scaling can be entered in the tag configuration. Use linear scaling, enter the raw count range from the Range Table, select data type Float and enter the corresponding high and low input voltages. Scaled values can be clamped to prevent out of range scaling errors and can be negated if desired. Enter units of Volts.

Click OK to add the tag.
4.5.3 Creating Tags for the MAQ20-VO or -IO Output Module

On the demonstration system, MAQ20-VO module Ch 0 provides a -10V to +10V output signal which drives the yellow LED bar display, labeled VOUT1, from zero to full scale, and Ch 4 drives the TC Heat 1 control which simulates an elevated temperature measured by MAQ20-JTC module Ch 6.

To determine the address to write to, use the Address Map for the MAQ20-VO or -IO Output Modules found in the appendix of MA1042 MAQ20 Voltage & Current Output Module Hardware User Manual. An excerpt from the MAQ20-VO Address Map is shown below. Channel Data is stored starting at address 1000.

NOTE: When a module is registered in a system, addresses are offset by 2000 * R, where R is the Registration Number.

<table>
<thead>
<tr>
<th>Address Range 1000 - 1699 : Module Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Address</td>
</tr>
<tr>
<td>1000</td>
</tr>
</tbody>
</table>

The MAQ20-VO module in the demonstration system has a registration number of 3 and an address offset of 2000 * 3 = 6000.

To write to Holding Registers using the OPC server, use base address range 400000. The addresses to write to are then 400000 + 6000 (address offset) + 1000 (MAQ20-VO Ch 0) = 407000 and 400000 + 6000 (address offset) + 1004 (MAQ20-VO Ch 4) = 407004.

Choose Data type = Short and Client access = Read/Write. Scan rate is only for non-OPC clients.

![Tag Properties](image)

MAQ®20 output module ranges can be set on a per-channel basis. This can be set or checked using the MAQ®20 Configuration Software Tool or ReDAQ® Shape Software for MAQ®20.
Data stored in the MAQ®20 addresses is in raw counts. To convert this to engineering units, use the count mapping tables in the appendix of the specific MAQ®20 Hardware User Manual.

MAQ20-VO Range Table

<table>
<thead>
<tr>
<th>Range</th>
<th>Standard Output Voltage</th>
<th>Equivalent Counts</th>
<th>Over/Under Range</th>
<th>Equivalent Counts</th>
<th>Volts per Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-10V to +10V (Default)</td>
<td>98 to 3998</td>
<td>-10.5V to +10.5V</td>
<td>0 to 4095</td>
<td>5.128*10^-3</td>
</tr>
<tr>
<td>1</td>
<td>-5V to +5V</td>
<td>1073 to 3023</td>
<td>-5.25V to +5.25V</td>
<td>1024 to 3072</td>
<td>5.128*10^-3</td>
</tr>
<tr>
<td>2</td>
<td>-2.5V to +2.5V</td>
<td>1561 to 2536</td>
<td>-2.625V to +2.625V</td>
<td>1536 to 2560</td>
<td>5.128*10^-3</td>
</tr>
<tr>
<td>3</td>
<td>0 to +10V</td>
<td>2048 to 3998</td>
<td>0 to +10.5V</td>
<td>2048 to 4095</td>
<td>5.128*10^-3</td>
</tr>
<tr>
<td>4</td>
<td>0 to +5V</td>
<td>2048 to 3023</td>
<td>0 to +5.25V</td>
<td>2048 to 3072</td>
<td>5.128*10^-3</td>
</tr>
<tr>
<td>5</td>
<td>0 to +2.5V</td>
<td>2048 to 2536</td>
<td>0 to +2.625V</td>
<td>2048 to 2560</td>
<td>5.128*10^-3</td>
</tr>
</tbody>
</table>

Using this information, scaling can be entered in the tag configuration. Use linear scaling, enter the raw count range from the Range Table, select data type Float and enter the corresponding high and low output voltages. Scaled values can be clamped to prevent out of range scaling errors and can be negated if desired. Enter units of Volts.

Click OK to add the tag.
4.5.4 Creating Tags for the MAQ20-DIOL Discrete Input/Output Module

On the demonstration system, MAQ20-DIOL module output channels DO1 and DO2 are connected to Motor Pot 1 FWD and REV controls respectively. Input channels DI2 and DI3 are connected to bat toggle switches SW3 and SW4 respectively. The discrete input channels read logic 1 for the bat toggle switch in the left position and the LED off and logic 0 for the bat toggle switch in the right position and the LED on.

To determine the addresses to read from and write to, use the Address Map for the MAQ20-DIOL Discrete I/O Module found in the appendix of MA1043 MAQ20-DIOL Discrete I/O Module Hardware User Manual. An excerpt from the MAQ20-DIOL Address Map is shown below. Channel Data is stored starting at address 1000.

NOTE: When a module is registered in a system, addresses are offset by \(2000 \times R\), where \(R\) is the Registration Number.

<table>
<thead>
<tr>
<th>Start Address</th>
<th>Read/Write</th>
<th>Number of Registers</th>
<th>Contents</th>
<th>Description</th>
<th>Data Range</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>R/W</td>
<td>10</td>
<td>DIO States, Binary Representation, Inverted Logic&lt;br&gt;Addr 1000 = LSB&lt;br&gt;Addr 1009 = MSB</td>
<td>Example: Starting at address 1009 and decreasing to address 1000, MSB to LSB DI4 to DI0 and DO4 to DO0 = 1011011000. Data written to an input channel will be ignored. Data written to an output channel committed to a Special Function returns an error. Default = 1 for all channels.</td>
<td>DO0 – DO4&lt;br&gt;Inverted Logic&lt;br&gt;0 = switch closed&lt;br&gt;1 = switch open&lt;br&gt;DI0 – DI4&lt;br&gt;Inverted Logic&lt;br&gt;0 = input &gt; threshold&lt;br&gt;1 = input &lt; threshold</td>
<td>INT16</td>
</tr>
</tbody>
</table>

The MAQ20-DIOL module in the demonstration system has a registration number of 4 and an address offset of \(2000 \times 4 = 8000\).

To read from and write to Holding Registers using the OPC server, use base address range 400000. The addresses to write to are then:

\[
400000 + 8000 \text{ (address offset)} + 1001 \text{ (MAQ20-DIOL Ch DO1)} = 409001 \\
400000 + 8000 \text{ (address offset)} + 1002 \text{ (MAQ20-DIOL Ch DO2)} = 409002
\]

and the address to read from are:

\[
400000 + 8000 \text{ (address offset)} + 1001 \text{ (MAQ20-DIOL Ch DI2)} = 409007 \\
400000 + 8000 \text{ (address offset)} + 1001 \text{ (MAQ20-DIOL Ch DI3)} = 409008
\]

Although the data is Boolean, the MAQ20® stores it as INT16 and uses holding register R/W operations for access. Choose Data type = Short and Client access = Read/Write. Scan rate is only for non-OPC clients.
Click OK to add the tag.
5.0 Reading and Writing Data with the OPC Quick Client

Once the Channel and Device have been configured and Tags have been assigned, use the OPC Quick Client to view data and write data to addresses.

Start the Quick Client from the Tools pulldown menu, or by using the icon on the toolbar.

Tag groups are in individual folders. Click on a folder to view tags and active data. Data is updated at the rate specified in the Client with a default rate of 1000ms. When data changes, the Update Count increases.

The pane at the bottom shows all system events. Review this pane and the similar pane in KEPServerEX if there are problems connecting or acquiring data.

To write data to a channel, left-click on the channel to highlight it, then right click to open a menu with actions that can be performed.
Select either Synchronous Write or Asynchronous 2.0 Write, then enter the desired value either in counts or in scaled units and press Apply or OK.

6.0 Operating the MAQ®20 Process Simulator with the OPC Quick Client

The I/O channels presented in this manual are interrelated on the MAQ®20 Process Simulator, so the following exercises can be performed once the system has been configured as outlined in the previous sections.

6.1 Read Ambient Temperature

Select the MAQ20-JTC tag group. Observe the ambient temperature read on Channel 7. Touch the thermocouple protruding from the Process Simulator and observe the temperature change.
6.2 Read VOUT2 LED Bar Control Monitor

Select the MAQ20-VDN tag group. Observe the control voltage read on Channel 0. Rotate Motor Pot 1 and observe the voltage change.

6.3 Control the VOUT1 LED Bar

Select the MAQ20-VO tag group. Use Synchronous or Asynchronous Write to change the value of Channel 0 between -10V and +10V. Observe the change on the VOUT1 LED bar.

6.4 Control TC Heat 1

Select the MAQ20-VO tag group. Use Synchronous or Asynchronous Write to change the value of Channel 4 between 0V and +10V. The intensity of the TC Heat 1 indicator will indicate heater control voltage. Select the MAQ20-JTC tag group and observe the simulated temperature change on Channel 6. Select MAQ20-VDN tag group and observe the heat control voltage on Channel 5.
6.5 Read Bat Toggle Switch Position

Select the MAQ20-DIOL tag group. Operate switch SW3 on the Process Simulator and observe the state change on Discrete Input Ch 2. Operate switch SW4 on the Process Simulator and observe the state change on Discrete Input Ch 3.

![Image of OPC Quick Client](image1)

6.6 Control Motor Pot 1

Select the MAQ20-DIOL tag group. Use Synchronous or Asynchronous Write to change the value of Channel 1 to turn on or off forward motion (clockwise) or the value of Channel 2 to turn on or off reverse motion (counter-clockwise). The VOUT2 LED Bar indicates rotational position.

![Image of OPC Quick Client](image2)

The Motor Pot controls have the following truth-table:

<table>
<thead>
<tr>
<th>Channel DO1</th>
<th>Channel DO2</th>
<th>Motor Pot Rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>CW</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>CCW</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>None</td>
</tr>
</tbody>
</table>

7.0 OPC Server Setup File

The project created by following the steps in this manual is titled MAQ20DEMO-B.opf and is available for download from www.dataforth.com.
8.0 References

Dataforth Software Download Center
MAQ®20 Configuration Software Tool
ReDAQ® Shape Software for MAQ®20
MAQ®20 Hardware and Software User Manuals
http://www.dataforth.com/maq20_download.aspx

OPC Foundation
www.opcfoundation.org/
OPC Basics
www.opcfoundation.org/about/what-is-opc/

Wikipedia
OPC basics and links to related topics and references

Kepware Technologies
KEPServerEX FAQ database, video tutorials, software download, drivers
www.kepware.com/Support_Center
DATAFORTH WARRANTY
Applying to Products Sold by Dataforth Corporation

a. **General.** Dataforth Corporation ("Dataforth") warrants that its products furnished under this Agreement will, at the time of delivery, be free from defects in material and workmanship and will conform to Dataforth's applicable specifications or, if appropriate, to buyer's specifications accepted in writing by Dataforth. DATAFORTH'S OBLIGATION OR LIABILITY TO BUYER FOR PRODUCTS WHICH DO NOT CONFORM TO THE ABOVE STATED WARRANTY SHALL BE LIMITED TO DATAFORTH, AT DATAFORTH'S SOLE DISCRETION, EITHER REPAIRING, REPLACING, OR REFUNDING THE PURCHASE PRICE OF THE DEFECTIVE PRODUCT(S) PROVIDED THAT WRITTEN NOTICE OF SAID DEFECT IS RECEIVED BY DATAFORTH WITHIN THE TIME PERIODS SET FORTH BELOW:

i. for all software products including licensed programs, thirty (30) days from date of initial delivery;

ii. for all hardware products including complete systems, one (1) year from date of initial delivery;

iii. for all special products, sixty (60) days from date of initial delivery; and

Further, all products warranted hereunder for which Dataforth has received timely notice of nonconformance must be returned FOB to Dataforth's plant in Tucson, Arizona USA within thirty (30) days after the expiration of the warranty periods set forth above.

The foregoing warranties shall not apply to any products which Dataforth determines have, by buyer or otherwise, been subjected to operating and/or environmental conditions in excess of the maximum value established therefore in the applicable specifications, or any products that have been the subject of mishandling, misuse, misapplication, neglect, improper testing, repair, alteration or damage. THE PROVISIONS OF THE FOREGOING WARRANTIES EXTEND TO BUYER ONLY AND NOT TO BUYER'S CUSTOMERS OR USERS OF BUYER'S PRODUCTS. THE DATAFORTH STANDARD WARRANTY IS IN LIEU OF ALL WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE OR USE AND ALL OTHER WARRANTIES WHETHER EXPRESS, IMPLIED OR STATUTORY, EXCEPT AS TO TITLE. THE DATAFORTH STANDARD WARRANTY MAY BE CHANGED BY DATAFORTH WITHOUT NOTICE.

b. **Buyer Indemnity.** Buyer agrees to indemnify and hold Dataforth harmless from and against any and all claims, damages and liabilities whatsoever asserted by any person, entity, industry organization, government, or governmental agency of any country resulting directly or indirectly (i) from any acts not authorized by Dataforth in writing or any statements regarding the products inconsistent with Dataforth's product documentation or standard warranty, or (ii) from any breach or threatened breach by buyer, or by any of its employees or agents, of any term, condition or provision of this Warranty or (iii) from any warranty, representation, covenant or obligation given by buyer to any third party and not expressly provided for in this Warranty or (iv) for any non-compliance (in any form) of the products with any necessary or mandatory applicable laws, regulations, procedures, government or industry policies or requirements related to the use, sale or importation of the products. Such indemnification shall include the payment of all reasonable attorneys' fees and other costs incurred by Dataforth in defending such claim.

c. **Limitation on Damages.**

(1) IN NO EVENT SHALL DATAFORTH, ITS SUPPLIERS, LICENSORS, SERVICE PROVIDERS, EMPLOYEES, AGENTS, OFFICERS, AND DIRECTORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, COVER, ECONOMIC, PUNITIVE, ACTUAL, EXEMPLARY, CONSEQUENTIAL OR OTHER DAMAGES OF ANY NATURE INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR REVENUES, COSTS OF REPLACEMENT PRODUCTS, LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE ANY DATAFORTH PRODUCT.

(2) IN NO EVENT SHALL DATAFORTH BE LIABLE FOR DIRECT, SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY NATURE RESULTING FROM BUYER'S NONCOMPLIANCE (IN ANY FORM) WITH ALL NECESSARY OR MANDATORY APPLICABLE LAWS, REGULATIONS, PROCEDURES, GOVERNMENT POLICIES OR REQUIREMENTS RELATED TO THE USE, SALE OR IMPORTATION OF PRODUCTS.

(3) IN NO EVENT WILL THE COLLECTIVE LIABILITY OF DATAFORTH AND ITS SUPPLIERS, LICENSORS, SERVICE PROVIDERS, EMPLOYEES, AGENTS, OFFICERS, AND DIRECTORS TO ANY PARTY (REGARDLESS OF THE FORM OF ACTION, WHETHER BASED UPON WARRANTY, CONTRACT, TORT, OR OTHERWISE) EXCEED THE GREATER OF EITHER US$1000.00 (ONE THOUSAND DOLLARS U.S.A. CURRENCY) OR THE AMOUNT PAID TO DATAFORTH FOR THE APPLICABLE PRODUCT OR SERVICE OUT OF WHICH LIABILITY AROSE.
(4) DATAFORTH’S LIABILITY ARISING OUT OF THE PRODUCTION, SALE OR SUPPLY OF PRODUCTS OR THEIR USE OR DISPOSITION, WHETHER BASED UPON WARRANTY, CONTRACT, TORT OR OTHERWISE, SHALL NOT EXCEED THE GREATER OF EITHER US$1000.00 (ONE THOUSAND DOLLARS U.S.A. CURRENCY) OR THE ACTUAL PURCHASE PRICE PAID BY BUYER FOR DATAFORTH’S PRODUCTS. DATAFORTH’S LIABILITY FOR ANY CLAIM OF ANY KIND SHALL IN NO CASE EXCEED THE OBLIGATION OR LIABILITY SPECIFIED IN THIS WARRANTY.

d. Technical Assistance. Dataforth’s Warranty as hereinabove set forth shall not be enlarged, diminished or affected by, and no obligation or liability shall arise or grow out of, Dataforth’s rendering of technical advice, facilities or service in connection with buyer’s order of the products furnished hereunder.

e. Warranty Procedures. Buyer shall notify Dataforth of any products which it believes to be defective during the applicable warranty period and which are covered by the Warranty set forth above. Buyer shall not return any products for any reason without the prior authorization of Dataforth and issuance of a Return Material Authorization (“RMA”) number. After issuance of a RMA number, such products shall be promptly returned by buyer (and in no event later than thirty (30) days after the Warranty expiration date), transportation and insurance prepaid, to Dataforth’s designated facility for examination and testing. Dataforth shall either repair or replace any such products found to be so defective and promptly return such products to buyer, transportation and insurance prepaid. Should Dataforth’s examination and testing not disclose any defect covered by the foregoing Warranty, Dataforth shall so advise buyer and dispose of or return the products in accordance with buyer’s instructions and at buyer’s sole expense, and buyer shall reimburse Dataforth for testing expenses incurred at Dataforth’s then current repair rates.

f. Repair Warranty. Dataforth warrants its repair work and/or replacement parts for a period of ninety (90) days from receipt by buyer of the repaired or replaced products or for the remainder of the warranty period for the initial delivery of such order as set forth in paragraph a above, whichever is greater.

g. Critical Applications. Certain applications using Dataforth’s products may involve potential risks of death, personal injury, or severe property or environmental damage (“Critical Applications”). DATAFORTH’S PRODUCTS ARE NOT DESIGNED, INTENDED, AUTHORIZED, OR WARRANTED TO BE SUITABLE FOR USE IN LIFE-SUPPORT DEVICES OR SYSTEMS, SAFETY EQUIPMENT, NUCLEAR FACILITY APPLICATIONS OR OTHER CRITICAL APPLICATIONS WHERE MALFUNCTION OF THE PRODUCT CAN BE EXPECTED TO RESULT IN PERSONAL INJURY, DEATH OR SEVERE PROPERTY DAMAGE. BUYER USES OR SELLS SUCH PRODUCTS FOR USE IN SUCH CRITICAL APPLICATIONS AT BUYER’S OWN RISK AND AGREES TO DEFEND, INDEMNIFY AND HOLD HARMLESS DATAFORTH FROM ANY AND ALL DAMAGES, CLAIMS, PROCEEDINGS, SUITS OR EXPENSE RESULTING FROM SUCH USE.

h. Static Sensitive. Dataforth ships all product in anti-static packages. Dataforth’s Warranty as hereinabove set forth shall not cover warranty repair, replacement, or refund on product or devices damaged by static due to buyer’s failure to properly ground.
Application Support

Dataforth provides timely, high-quality product support. Call 1-800-444-7644 TOLL-FREE.

Returns/Repair Policy

All warranty and repair requests should be directed to the Dataforth Customer Service Department at (520) 741-1404. If a product return is required, request a Return Material Authorization (RMA) number. You should be ready to provide the following information:

1. Complete product model number.
2. Product serial number.
3. Name, address, and telephone number of person returning product.
4. Special repair instructions.
5. Purchase order number for out-of-warranty repairs.

The product should be carefully packaged, making sure the RMA number appears on the outside of the package, and ship prepaid to:

Dataforth Corporation
3331 E. Hemisphere Loop
Tucson, AZ 85706 USA

An RMA Request Form and instructions for processing are also found at www.dataforth.com.

The information provided herein is believed to be reliable; however, DATAFORTH assumes no responsibility for inaccuracies or omissions. DATAFORTH assumes no responsibility for the use of this information, and all use of such information shall be entirely at the user's own risk. Application information is intended as suggestions for possible use of the products and not as explicit performance in a specific application. Prices and specifications are subject to change without notice. No patent rights or licenses to any of the circuits described herein are implied or granted to any third party. DATAFORTH does not authorize or warrant any DATAFORTH product for use in life support devices and/or systems.